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Understanding Windows 
 

In this document we will discuss procedures and practices that will allow you to have a 
safe and enjoyable experience with your Windows computer. Some precautions you do everyday 
and some require running a process. We will discuss my “Fave 5 tips to improve your computing 
experience.” Other processes we will discuss are how to use your newly acquired flash drive, 
printer management, and internet use. After reading this documentation if you have any other 
questions you can call the office or contact your field rep.   
 

The first procedure we will discuss is keeping Windows up to date. How do you know if 
Windows is up to date? Most of the time if your not up to date you will get an icon in your far 

bottom right toolbar that has a yellow shield. This is to let you know that 
there are updates available for your workstation. If you are using Windows NT, 2000 or XP 
machines you need administrator privileges to do updates. If you do not have this shield in your 
toolbar you can always check to see if you are up to date by going to Microsoft’s website. To do 

this you will “Select , Select “All Programs,” Select “Internet Explorer.” In the 
Internet Explorer window go to "Tools" --> click on "Windows Update."  

 
 
Once you click on Windows Update you will select which option you want windows to search 
for updates. The two options are Express and Custom. It is recommended that you use the 
Express. This option will assure you that you will get high priority updates if there is any 
available. Once you select Express it will scan your computer to see what updates you need. 
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This screen will appear if you do not have any updates available.  
 

 
  
However, if you do have updates your screen may look like this. 
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To install the updates you will select the “Install Updates” to the left of the screen. 
 

 
 
Once you select “Install Updates” you will see the below screen. This is letting you know that it 
is installing the updates.  

 
 
You may have to restart your computer after the installation is completed. Without restarting 
your computer most updates will not work. If you are required to restart your computer do so. 
Go thru the same process to make sure there are no more "Critical Updates." Visit the windows 
updates site often quarterly at the very least. Insure all critical updates (security related) have 
been applied. If updates are available, install them and keep going back to the windows update 
site until there are 0 critical updates left. 
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 If you do not want to go through this procedure your Windows can be set to download 
and install updates automatically. Go to Start> Control Panel> Automatic Updates. Here you can 
change the settings of how you receive updates. Double-Click on “Automatic Updates” to open 
it.                                                               

 

 
 
Once it opens you will get the following screen. You will have four different options.  

1. Automatic (Recommended) – this option allows you to select the time and day of the 
week that you want your updates downloaded and installed 

2. Download updates for me, but let me choose when to install them. 
3. Notify me but don’t automatically download and install them. 
4. Turn off Automatic updates (NOT RECOMMENDED) . 

The option that your computer should be set at is #1 Automatic. This will insure your Windows 
system has the latest updates.   
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The second topic to discuss is “Know what not to download.” Before downloading any 
file, ask yourself these questions. Did you ask for this file? Did you click a link on a website to 
start this download, or did the download begin without any action on your part? If you did not 
start the download, you should be very cautious about the file. If you don't need the file, cancel 
the download. If you choose to save or run the file, make sure you know what it is for and what it 
will do to your computer before you proceed. Do you trust the website providing the file? Don't 
download any file unless you absolutely trust the website or publisher it is from. The website 
providing the file should describe what the file is for and provide any special details you need to 
know about the file to run it. If this information is not available, be cautious about downloading 
the file. Internet Explorer will block a file from downloading if it appears that you did not 
request the file. This might happen if a website tries to download files to your computer without 
your permission or if you requested a file but the download did not start immediately. What to 
do when a file is blocked. When a file is blocked, a message will appear on the Information bar. 
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If you are sure that you want to download the file, click the Information bar, and then click 
Download File 
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Once you click Download File this box will appear. 

 

It gives you three options: “Run, Save, or Cancel”. If you click “Run” it will download the file 
and place the setup in a temporary folder. If you click “Save” you will be prompted to select 
where you want to save the. If you want a copy of the file you will want to select “Save.” 
“Cancel” does what it says. It cancels the download process. Before downloading also make sure 
your antivirus program is up and running in auto-scan mode.  

The third process we will discuss is to “Limit your customizations.” I know that the 
interactive screensavers are fun, but they can also cause problems on your workstation. It is the 
same if you download custom themes. They look great, but you are making your workstation 
vulnerable to viruses. Whenever you download a file, whether it is a program file or it is a 
screensaver it takes up critical space on your workstation. Your workstation only has a limited 
amount of unused space. Every file or program that you download creates a process for your 
workstation to run. The more processes that you have running the slower your computer will 
operate. So, make sure that what you download is necessary to help you with your daily work.  

The fourth of the “Fave 5” is practicing safe email. One of the most effective ways to 
practice safe emails is to minimize the use of email to only official business. Do not use your 
business email at any websites unless required to perform your business functions. Emails are 
one of the most popular modes of virus distribution these days. So to keep your computer 
healthy, and help prevent spreading viruses; you need to practice a few safety rules.  

1. Do not open attachments if you don’t know who they’re from. 
2. Even if you do know who it is from, and if the subject line sounds suspicious, 

contact your friend before opening. Viruses often “spoof” the “from” address line 
(masquerade as someone else. Usually getting the name from an infected 
computer’s address book – the infected computer could be a friend’s) Viruses also 
often try to come up with a compelling subject line to get you to open it.  

3. Turn off preview pane in Microsoft Outlook and Microsoft Outlook Express. The 
preview pane will open the infected email. To turn off the preview pane in    
Outlook Got to View > Reading Pane > Off. To turn off in Outlook Express Go to 
View > Layout > Uncheck the preview pane. 
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4. Before you open an attachment, check the suffix of the file. Anything that is a 
program file should be immediately suspected. Some of the program file 
extensions to watch out for are *.exe, *.com, *.pif, *.js, and *.vbs. 

5. Finally, keep your virus scan software up to date. It’s tempting to click “skip” 
sometimes when you’re asked to update your definition files – but never wise. 

The final process of the Fave 5 is “Computer + Internet = Virus.” In some cases this is 
true. However, if you follow some of the precautions I go over it will help keep your workstation 
free of viruses. Viruses come in many sources: Email, Floppy disks – If they have been inserted 
in another PC, Web sites – Can infect your PC, and CD-R’s may contain virus laden files if 
created on a virus infected PC. In other words, any data that your PC takes in is suspect except 
original installation cd’s and what you manually key in. Floppy disks have a write protect 
window on them. If you are going to put a floppy disk that you have created into another PC then 
please make sure to place the tab in locked position. This will prevent any data from being 
transferred to the floppy from an infected computer. 

A virus is not the only external damage that can happen to your PC. Beware of virus 
alerts forwarded from friends. A virus hoax can cause damage by making you think you have a 
virus and suggesting that you remove certain files from your PC. Usually these files are very 
important system files and they can cause your PC to become inoperative if removed. Please 
confirm all virus alerts at one of the antivirus websites before taking any action. 

Do not use any file trading programs like Kazaa, Morpheus, mIRC, IRC, Winmx, Bear 
Share, and Lime Wire. Trading files is not a requirement of most computer related jobs and 
could put you or your company at unnecessary risk. If you must file trade then do it at home. 
Another popular site that is used that may contain viruses is MySpace. 

There are programs available that will help you protect your computer. One of the most 
effective is up-to-date anti-virus software, such as AVG. Use an antivirus product that also 
includes spyware/adware protection. If it is not included in your antivirus package you should 
obtain some form of protection. Spybot Search & Destroy, Ad-Aware SE, and CCleaner are free 
for personal use. Install them and learn to use them properly. Perform a scan of your PC 
monthly, more often for very active web surfers. How to install the Spybot Search & Destroy 
will be discussed below. If you do not have the program on your workstation visit the following 
site and download the programs.  

Spybot Search & Destroy 
http://www.filehippo.com/download_spybot_search_destroy/download/93d9163739cc9c2cf3313
fbf08c3a1f4/ 

Ad-Aware SE                                                                               
http://filehippo.com/download_ad-aware/download/5b34323cc996a427f7bfdfaa6c41817c/ 

Follow the onscreen instructions to install Spybot and Ad-Aware. The following shows you how 
to use Spybot. 
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Start Spybot 

On your desktop, double click on the icon for Spybot - S&D. The program will now open and 
will appear as shown in Figure 1 below.  

 

 
Figure 1. Spybot - S&D welcome screen 

  

 

 

Update Spybot  

Click on the Update button in the left panel if needed. Click the Search for Updates button. The 
Spybot program will connect to the update servers and check for new spyware definition files. 
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You will then be presented with another screen shown in Figure 2. Check mark all available 
updates and clicks the Download Updates button. This will enable Spybot - S&D to recognize 
and remove additional Spyware/Hijacking threats as they are released. 

 

 
Figure 2. Select and Download updates 

  

Failed updates? 

If the updates fail to download you may need to change where you are getting them from. As 
shown In Figure 3 you can choose a different update server by clicking on the arrow beside the 
listed server. Choose a different server and click on Download Updates again. 
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 Figure 3. Update Server selection 

  

Immunize 

Spybot - S &D also has the ability to immunize your computer from downloading and running 
known malicious ActiveX controls or other programs from known malware sites.  

You can access the Immunize feature by clicking on the Immunize button on the left hand 
vertical toolbar. When you click on the Immunize button you will be presented with a screen 
similar to figure 4 below. 

  



 Local Government Corporation 
Understanding Windows 

 

March 12, 2009                                       Local Government Corporation                                           Page 12 of 31 
 

 
Figure 4: Immunize Screen 

  

Figure 4's message says "Please immunize" at the end like there is still something else to do. 
Click OK. Immunization is not complete until the Green Plus sign (with the word Immunize 
beside it) is clicked.  

  

Check for Problems with Spybot - S&D 

After updating Spybot the program sometimes restarts. You will be presented with the same 
screen as shown in Figure 1. Click on the Search and Destroy button in the left hand column. 
Then click on the button called Check for Problems. 

The program will automatically start and search your hard drive, registry, and other locations for 
traces of Spyware, Hijackers, and other malware. When it finds software that it recognizes, it 
will add it to a list of items to remove.  As of this writing, Spybot - S&D knows a little over 
17,000 different types of Spyware and Hijackers, so as you can imagine it may take a while. 
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Figure 5 below shows Spybot - S&D in a scanning state as it searches for Spyware and 
Hijackers. Note the status and progress bars at the bottom. 

 
Figure 5. Check for Problems 

  

 

Examining Information about listed entries 

It is possible to see what registry entries or files correspond with the found items. Examine figure 
6 below and we will describe how to see information about each entry. It is not necessary to 
further analyze the problems found, however, if your curiosity gets the best of you just highlight 
(select) the error that you want more information about and click the double blue arrows to the 
right of the entries. A panel will display more information about the selected error. Most 
problems found will likely be relatively harmless cookies. However, Spybot can and may find 
serious violations as well.  
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Figure 6. Problems found 

Fixing Problems 

When finished scanning Spybot will have already selected the known errors as shown in figure 6. 
All that's left is to click the Fix Selected Problems button.  

If you have Windows XP or Windows ME and have System Restore enabled, Spybot - S&D will 
create a restore point before continuing. This will allow you to revert back to previous 
configurations in case you remove needed components (why would you need to put spyware 
back?). Spybot - S&D will then ask you for confirmation on whether or not you would like to 
continue. Press the Yes button. Spybot will proceed to remove the spyware. 

If it has trouble removing any spyware, because that particular component is running memory, 
you will see a screen like Figure 7, asking if it would be ok to run Spybot - S&D on the next 
reboot before any other applications start running.  
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Figure 7. Prompt for Run on next Reboot 

  

You should reply yes to this. The next time, you start Windows; Spybot will run automatically 
before allowing you access to your desktop. It will fix any of the programs it could not fix 
previously.  

At this point you will be presented with the list of found entries again, but now there will be 
large green checkmarks next to the items that Spybot - S&D was able to remove. When you 
close Spybot the computer will finish logging you on and give control of your computer back to 
you. 

Using your newly acquired flash drive. Some of you are familiar with using a flash drive. 
While others this is new. I will go through how to use a flash drive from inserting it into your 
workstation to how to remove it.                                                                                                                                          

What is a USB Flash Drive? USB flash drives are memory data storage devices 
integrated with a USB (universal serial bus) connector. They are typically small, lightweight, 
removable and rewritable. Flash drives are meant as a way to get files to and from multiple 
computers. They are not meant for backups. With nothing being mechanically driven in a flash 
drive, the name is somewhat of a misnomer. It is called a "drive" because it appears to the 
computer operating system (and the user) in a manner identical to a mechanical disk drive, and is 
accessed in the same way. 

 What are the advantages of using a flash drive? USB flash drives can offer potential 
advantages over other portable storage devices, particularly the floppy disk. They are more 
compact, faster, hold more data, are more reliable due to their lack of moving parts, and have a 
more durable design. It has become increasingly common for computers to ship without floppy 
disk drives. USB ports, on the other hand, appear on almost every current mainstream PC and 
laptop. 

What can you store on a Flash Drive? Any digital file from a Word document, 
photograph, and music (MP3 and other formats). The file can be saved and retrieved from any 
computer just like a floppy disk or CD. 

 
 Where do I insert my flash drive? Most computers have USB ports on the front. If you do 
not see any ports on the front take a look at the back of your computer. If you do have one in the 
front it will look similar to the following picture.  
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How to copy files to a flash drive on a PC. 

1. Most flash drives have what is call “Plug-and-Play.” What this means is when you insert 
your flash drive into the USB slot a window will appear. This option allows you to 
quickly open your flash drive to the files and folders it has on it.  

       

If your flash drive does not have this you can still open the flash drive. Open My 
Computer by double clicking on the My Computer icon on your desktop. Most computers 
have a hard drive such as (C:) and a few removable storage devices such as floppy drive 
and a CD ROM drive.  
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2. Insert the flash drive into the USB port. Most USB ports are now on the front of a PC but 
if you can’t see them there look on the back of your PC. Watch the left hand panel to see 
where the USB flash drive appears. Most flash drive will appear as “Removable Disk.” 

 
 
3. Navigate to My Documents or a location from which you want to transfer files to the 

flash drive. Select the file(s) or folder(s) you want to save to the flash drive by clicking 
on them. To select more than one, hold down the CTRL key while you click and select all 
of the files you wish to save. 

4. Right-click on the file(s) or folder(s) you have selected and click “Copy”, then navigate 
to your flash drive through My Computer. Double-Click your flash drive to open. In the 
white area Right-Click and “Paste.” This will put a copy of the file(s) or folder(s) you 
have selected on your flash drive. If you want to put more files or folders on your flash 
drive follow Step 3 & 4. If you wish to remove the flash drive follow the Step 5. 

5. DO NOT IMMEDIATELY REMOVE THE FLASH DRIVE FROM THE USB 
PORT. If you do this there is a possibility that it will corrupt your data or damage your 
flash drive. Instead double-click on the “Remove Hardware” icon located in the System 
Tray. You can also click on the “Remove Hardware” one time and it will display the 
available hardware to remove. The System Tray is located in the bottom left of your 
computer screen.  

       
 

Once you double click this screen will appear. If you are unsure of which device to 
remove you can put a check mark in the “Display Device Components.” Once you place 
the check mark it will give you more of a description. However, most of the time you will 
select the “USB Mass Storage Device.” If you have more than one flash drive attached 
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you may want to place a check mark in the “Display Device Components” to make sure 
that you remove the correct flash drive. Note: if you attach a phone, or a camera it looks 
like it is a mass storage device.  

 

 

6. When you see the following message appear in the System Tray “Safe To Remove 
Hardware,” it is safe to remove your flash drive from the USB port. 

You can also save files directly to a flash drive just as you save them to My Documents. 

1. In your application, for example Microsoft Word. Go to File> Save As> Select your flash 
drive from the drop down box> Click Save. 
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How to copy files from your flash drive to your computer.  

1. Make sure that your flash drive is inserted into your computer.  
2. Go to My Computer and Double-Click on your flash drive icon “Removable Disk.” 
3. Double-click on the flash drive to locate the file(s) or folder(s) you want to copy to your 

computer. Select the file(s) or folder(s) you want to copy by left-clicking on them. To 
select more than one, hold down the CTRL key while you click and select all of the files 
or folders you wish to copy. 

4. Right-click on the file(s) or folder(s) you have selected and choose “Copy.” 
5. Open “My Documents” or the location to which you want to transfer files from the flash 

drive. 
6. Right-Click, then select “Paste” . 
7. Once the transfer has completed you can now follow the above process to Safely 

Remove your hardware. 
 

 If you are planning on purchasing a printer and you want to use if with Local 
Government software check with us to see if it will work. If you purchase a laser printer make 
sure that it has a PCL 6 driver available. If you purchase a printer from a third-party vendor there 
is no guarantee that we can make it print out of Local Government software. There will also be a 
charge to install a third-party printer even if we can’t get it to work.  How do you add a printer to 
your workstation? In the instruction below I will show you how to add a printer that is connected 
directly to your workstation. If you have a printer that has network capabilities you will want to 
have a hardware rep install it or your IT person. 
 
Go to Start> Printers and Faxes> File> Add printer> Add Printer Wizard 
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Once you click add printer another box will appear this is the Add Printer Wizard.  

 
Click Next. 
 
 
This box wants to know how the printer will be connected. Some printers come with a Plug and 
Play feature. This allows you to select “Local printer attached to this computer” and select 
“Automatically detect and install my Plug and Play printer.” Since this printer does not support 
“Plug and Play” we will select “Local printer attached to this computer.”  
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Click Next. 
 

 
Select your port. Your port will be LPT1: (Recommended Printer Port) since it is connected 
directly to the back of your workstation. Select LPT1 and click Next. 
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From the list you will select your printer Manufacturer. Then you will select the printer model 
from the Printers options. In the example my manufacturer is a Canon. My printer model from 
the list is a Canon S520. Once you have selected your printer and model click Next.  
 

  
Your next screen wants you to assign a printer name. Most of the time the printer name will 
default in as mine did. However, you do not have to use that name. You can assign the name that 
you want to it by typing in the Printer Name box. If you want this printer to be your default 
printer through your Windows programs you can select Yes to setting it as your default printer. 
Once you have added your printer name and selected if you want it to be your default printer 
click Next. 
 



 Local Government Corporation 
Understanding Windows 

 

March 12, 2009                                       Local Government Corporation                                           Page 24 of 31 
 

 
This screen is telling you that you can share the printer that you are adding. Most of the time you 
will leave it marked “Do not share this printer.” What does sharing your printer do? It allows 
other people in your office the option to print to this printer. Click Next.  
 

 
This is the Print Test Page screen. It asks you the question if you want to print a test page. You 
will select yes. This will print a page to the printer once it is installed. Select Yes and click Next. 
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This is the complete screen. It shows you the printer settings that you selecting during setup. If 
you notice something that needs to be changed you can click back to fix the error. If everything 
is correct you will select Finish. 
 

 
When you click Finish on the previous screen this screen appears. This is installing the printer 
drivers for your printer. Once it is finished the print test page screen will pop up. 
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When you get to this screen you can check your printer for the printer test page. Once you get the 
test page and it looks correct, click Ok. It will take you back to your Printers and Faxes screen. 
You now have a new printer in the list. Congratulation you have successfully installed a printer 
on your workstation. 
  
 The printer that you added to your workstation has the option for you to see if you have 
documents waiting to be printed, and it also has the ability to cancel, restart, and delete print 
jobs. How do you see if you have documents waiting to be printed? Go to Start> Printers and 
Faxes. Find the printer you want to check. In the main Printer and Faxes screen your printer will 
have a number below the name if it has a print job. If the printer does not have a print job it will 
have a zero (0) below the name.  
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In order for you to see the document name, status of the printing, and the number of pages you 
will need to Double-Click on the printer or Right-Click and select Open. Once it is open you will 
see this screen. It will show all of the documents that are waiting to be printed. Once it prints the 
document it clears out the screen. 

 
 
  
 
 
 
 
 How do I Cancel/Restart/Delete a print job? Go to Start> Printers and Faxes. You have 
two option of Canceling, Restarting, or Deleting a print job. The first option we will discuss is 
the easiest, Right-Click on the printer that you want to Cancel or Delete the print job. You will 
get the below screen.  

 
You have the option to Open the printer, you can Pause the document, or Cancel All Documents 
(Delete). If this printer is not your default printer for Windows printing you can set it now. Once 
you click Pause the status of the printer will change. When are ready to resume printing Right-
Click on the printer and click Resume. 
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Once you click Cancel All Documents you will be prompted Are you sure you want to cancel all 
documents for ‘Canon’. If you want to cancel All documents for the printer click yes. However, 
if the printer has multiple prints jobs and you only want to cancel one of the print jobs you will 
need to use the second option(discussed later) to Cancel/Delete a print job. When you click yes 
the printer will cancel all documents and it will have a zero (0) for print jobs that are waiting to 
be printed. 

 
 
 The second option to Cancel/Restart/Delete a print job you will have to go to Start> 
Printers and Faxes. Navigate to the printer that you want to Cancel/Restart/Delete a print job. 
Double-Click on the printer to open it. You can also Right-Click and select open. Once you do 
this you will see the window that shows the document name, printing status, and number of 
pages. This is the Windows print manager.  

 
 
Click Printer. This displays option for this document. You can also Right-Click on the document.  
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Cancel/Delete a print job this way allows you the option of selecting which document you want 
to Cancel/Delete. If you click Pause the Status of the print job will change to Paused. 
 
 

 
 
If you click Cancel you will be prompted with “Are you sure you want to cancel this document.” 
If you are sure you will click Yes. Once the document has cancelled the screen will be cleared. 
Like the screen below. 
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 How much does it cost my office to use Inkjet printer vs. Laser printer? Color inkjet 
printers have been fixtures in most offices for many years. They are cheap in some cases they are 
under $60, they last a couple of years and everybody in the office uses them. So they must be 
perfect tools for the office, right? Maybe not.  
 
 When you do the math, inkjets may cost a whole lot more than you realize. What printer 
manufacturers don’t fully explain to the customer is the true cost of owning a low-cost printer. A 
general rule is, the cheaper the printer, the more expensive the cost of the ink cartridges. While 
the printers are almost given away, the refills bring in a fortune for the big-printer companies. 
  
 I will give you an example using a Canon Color Bubble Jet printer. The cost of the printer 
is $55. The average cost of the ink for the Canon printer is $19, but it prints a measly 170 pages 
which is about 11 cents per page. Even if you print very little the cost quickly adds up. Let’s put 
this into perspective. Seven pages a day times 300 days equals 2100 pages. This is an ink bill of 
$235.60 per year. If you own the printer for three years, the cost of the cartridges come to over 
$700 or about 13 times the original cost of the printer.  
 
 Seven pages a day is a conservative estimate. Inkjet printers typically do not print as fast 
as laser printers. It isn’t unusual to see cartridge-error messages when the cartridges are perfectly 
fine. Or have the printer go crazy and spit out ink in an endless stream. The printers are also 
setup in a way the makes it very difficult to change the amount of ink is uses. A printer not used 
for a week or more often results in dried-up ink cartridges that must be replaced, laser printers a 
more forgiving.  
 
 In comparison laser printers are much faster and a lot quieter, and almost hassle free. 
However, it’s the math that makes them stand out. An example of this is if you buy an HP laser 
printer with an estimated cost of $400, plus the $115 toner cartridge, which yields 8000 pages. If 
you print 40,000 pages will cost you $400 for the printer plus $575 for the ink toner for a total of 
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$975 total cost. That comes out to be about 2 cents per page, or eight times less than an inkjet 
printer.  
 
 Adding to the appeal of the laser printer is that the prices continue to fall and the 
available products continue to grow. To bring the cost of laser printing down even more you can 
purchase inexpensive replacement or remanufactured cartridges. Replacement cartridges are 
becoming more available for inkjet printers. However, the success rate is sporadic to say the 
least. Only about 20 percent of black inkjet cartridges and about 50 percent of colors can’t be 
refilled or reused. Almost 99 percent of laser toner cartridges can be remanufactured.  
 
 Before you purchase any type of printer you should calculate the printing cost per page. 
You will do this by adding the cost of the cartridge and divide that by the number of pages the 
cartridge will print. For example, the cost of the cartridge is $20. The cartridge will print 800 
pages, then the cost per page will be $20/800=$0.03 (3 cents per page). 
 
 The internet can be a fun and entertaining tool if it is used wisely. As we discussed above 
it is a good idea to have anti-virus software, such as AVG, and keep your Windows operating 
system updated. We have noticed in recent years that when a customer downloads Google or 
Yahoo toolbars it can affect the operation of their Local Government software. Not only can it 
affect your Local Government software, but it is a resource “hog.” For example, certain Google 
applications will try to index the hard drive which will periodically cause a slow down on the 
performance of your workstation. Most of the toolbars are riddled with Spyware and Malware. 
What is Spyware? Spyware is computer software that is installed surreptitiously on a personal 
computer to intercept or take partial control over the user's interaction with the computer, 
without the user's informed consent. What is Malware? Malware, a portmanteau from the words 
malicious and software, is software designed to infiltrate or damage a computer system without 
the owner's informed consent. You do not want either of these on your workstation.  
  
 According to a 2005 study by AOL and the National Cyber-Security Alliance, 61 percent 
of surveyed users' computers had some form of spyware. 92 percent of surveyed users with 
spyware reported that they did not know of its presence, and 91 percent reported that they had 
not given permission for the installation of the spyware. As of 2006, spyware has become one of 
the preeminent security threats to computer systems running Microsoft Windows operating 
systems. 
 
 Weather Bug is another of the resource “hogs.” It does and will slow down your 
computer. It too has caused problems with the performance of your workstation and the Local 
Government software. Be cautious of what your download from internet. A good rule of thumb 
that I practice is “If it does not help me get my job done, then I do not need to download it.” That 
means no games, screensavers, wallpapers, and especially no Weather Bug! 
 
 


